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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.  The TReK CFDP 

application provides the capability to transfer files using the Consultative Committee for 

Space Data Systems (CCSDS) File Delivery Protocol (CFDP). 

 

This tutorial provides step-by-step instructions describing how to perform common 

application functions.   

 

This tutorial uses screen dumps taken on a Windows computer.  However, the steps are 

the same regardless of whether you are running on Windows or Linux.   

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK 

software, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:            trek.help@nasa.gov 

Telephone:      256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time) 

Fax:                 256-544-9353 

 

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time.  The HOSC Help Desk (256-544-5066) can provide assistance as needed 

and is available 24x7. 

 

 

3 Introduction 

The TReK CFDP application provides the capability to transfer files using the 

Consultative Committee for Space Data Systems (CCSDS) File Delivery Protocol 

(CFDP).   

 

The CCSDS File Delivery Protocol (CFDP) was developed by the Consultative 

Committee for Space Data Systems (CCSDS).  Official specifications are contained in a 

CCSDS document called the CFDP Blue Book (available at www.ccsds.org).  The CFDP 

protocol provides reliable transfer of files from one computer to another, and has been 

designed to work well over space links.  It can be used to perform space to ground, 

ground to space, space to space, and ground to ground file transfers.   

 

http://www.ccsds.org/
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CFDP requires a sender and a receiver.  The sender and receiver must be configured and 

running at the same time to perform a file transfer.  Each party is referred to as an 

“Entity”.  The sender is an entity and the receiver is an entity.  Each “Entity” must have a 

unique Entity ID.   For example:   

 

 

Figure 1 CFDP Sender and Receiver 

 

To move a file from one computer to another, you will enter one or more CFDP 

Commands (primitives) to indicate the action to be taken.  The syntax of a primitive is as 

follows: 

 

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path] 

 

The TReK CFDP application provides support for CFDP over User Datagram Protocol 

(UDP) and CFDP over Bundle Protocol (BP) using the Jet Propulsion Lab (JPL) 

Interplanetary Overlay Network (ION) Delay Tolerant Networking software.  The CFDP 

over UDP configuration option is referred to as Native CFDP.  The CFDP over BP 

configuration option is referred to as ION CFDP.  In the Native CFDP configuration, the 

application uses UDP sockets and a Goddard Space Flight Center (GSFC) CFDP library 

that performs the CFDP work.  In the ION CDFP configuration, the TReK CFDP 

application communicates with the ION software which performs the CFDP work.     

 

There are differences in capabilities and syntax between the CFDP Native mode and the 

ION CFDP mode.  These differences are summarized below.  

 

Native CFDP Configuration 

The syntax of a primitive is as follows: 

 

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path] 

 

Native CFDP Example:  put class2 “D:\file1.txt” 2 “/home/kirk/file1.txt” 

 

The TReK CFDP application currently supports multiple CFDP Directives for both 

Native and ION CFDP modes. These are defined in the CFDP Directives section below.   

 

Valid Transmission values are class1 or class2.  Class1 does not guarantee reliable 

delivery of the file to the destination.  Class2 does ensure reliable delivery. 

 

The file you want to transfer is considered the “Source” and the location it should be 

transferred to is considered the “Destination”. 
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When entering a Source or Destination in a CFDP command line, it must be encapsulated 

in double quotes. 

 

 

ION CFDP Configuration 

The syntax of a primitive is as follows: 

 

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path] 

 

ION CFDP Example:  put //// “D:\file1.txt” 2 “/home/kirk/file1.txt” 

 

The TReK CFDP application currently supports multiple CFDP Directives for both 

Native and ION CFDP modes. These are defined in the CFDP Directives section below.   

 

The Transmission entry for ION CFDP is composed of five properties.  Once these 

properties are configured, a “////” string is used to indicate that the pre-configured values 

should be used.  The “////” nomenclature is shorthand notation for the following 

combination of values: 

 
Lifespan/Bundle Protocol Class of Service/Expedited Priority Ordinal/Transmission Mode/Criticality 

 

When the values are empty it indicates that pre-configured values should be used for 

these properties. 

 

The Transmission properties are described below: 

 

Property Description 

Lifespan The lifespan is the bundle's "time to live" (TTL) in 

seconds.  The bundle is destroyed if its TTL has 

expired and it has not reached its destination. 

Bundle Protocol Class of Service The Bundle Protocol Class of Service defines the 

transmission priority of outbound bundles from three 

ION priority queues corresponding to bulk, standard, 

and expedited priorities.  The expedited priority 

queue must be empty before bundles in the standard 

or bulk queues are serviced by ION. Therefore, 

bundles with expedited priority should only be sent in 

critical/emergency situations. 

Expedited Priority Ordinal The expedited priority ordinal is only associated with 

the expedited priority class of service. 

Transmission Mode The transmission mode defines the reliability of 

bundle delivery to a destination.  The three 

transmission modes supported are best effort, assured, 

and assured with custody transfer.  

Criticality A critical bundle is one that has to reach its 

destination as soon as is physically possible.  For this 



TREK-USER-0006 

 4 

reason, bundles flagged as critical may not include 

custody transfer and require an ION configuration 

with contact graph routing.  In some cases, a critical 

bundle may be sent over multiple routes to ensure 

delivery to its final destination.  Critical bundles are 

placed in the expedited priority queue and should 

only be used in emergency situations. 

 

CFDP Directives 

The TReK CFDP application currently supports multiple CFDP Directives for both 

Native and ION CFDP modes.  This includes get and put, multiple filestore directives, 

and the message directive.  These are defined as follows: 

 

Directive Description 

append_file append a file at the remote entity to another file at the remote 

entity. 

bit_rate changes the aggregate file transfer bit rate, in real time, for local or 

remote entities hosting a TReK implementation of Native CFDP. 

The “affected EID” may be the local entity ID or a remote entity 

ID.  The "bit_rate" primitive is delivered to a remote entity in the 

form of a TReK CFDP message. 

close_rec_file send a directive to a TReK Record library to close one or all open 

record files.  If the record file name is not included in the 

primitive, all open record files associated with the TReK Record 

library are closed.  The TReK Record library automatically opens 

a new record file after it closes a current record file.  The “affected 

EID” may be the local entity ID or a remote entity ID.  The 

"close_rec_file" directive is delivered to a remote entity in the 

form of a TReK CFDP message.   

create_dir create a directory at the remote entity. 

create_file create an empty file at the remote entity. 

delete_file delete a file at the remote entity. 

deny_dir delete a directory at the remote entity.  (like remove_dir, but does 

not fail if the directory does not exist. Directory must be empty.) 

deny_file delete a file at the remote entity.  (like delete_file, but does not fail 

if the file does not exist)  

get copy one file from the remote entity to the local entity. (File 

cannot be empty.) 

message send a text string to the remote entity. 

put copy one file from the local entity to the remote entity. (File 

cannot be empty.) 

remove_dir delete a directory at the remote entity (directory must be empty).   

rename_file rename a file at the remote entity. 

replace_file replace a file (contents) at the remote entity with another file 

(contents) at the remote entity. 
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Some directives only require a Source.  The following table describes what is required for 

Source and Destination for each directive.  Name of file, filename, and name of directory 

refer to an absolute path. 

 

Directive Source (first file) Destination (second file) 

append_file name of file whose contents 

form first part of new file and 

name of the new file 

name of file whose contents will form 

second part of new file 

bit_rate aggregate file transfer bit rate  

close_rec_file name of the TReK record 

library device  

name of the TReK record file to close 

(if not included all record files 

associated with the record device are 

closed)  

create_dir name of directory to be created  

create_file filename to be created  

delete_file filename to be deleted  

deny_dir name of directory to be deleted  

deny_file filename to be deleted  

get file or directory name of file(s) 

to retrieve   

file or directory name for file(s) 

retrieved  

message message  

put file or directory name of file(s) 

to send 

file or directory name for file(s) sent 

remove_dir Name of directory to be 

deleted 

 

rename_file old filename new filename 

replace_file filename whose contents are to 

be replaced 

filename whose contents will replace 

the contents of the first filename 

 

When entering a Source or Destination in a CFDP command line, it must be encapsulated 

in double quotes. 

 

Note:  The Get directive is not supported in all ISS CFDP Native and ION 

implementations.  Filestore and message directives are not supported in all ISS CFDP 

Native implementations.  They are supported by TReK when both the sender and receiver 

are TReK CFDP implementations (TReK CFDP application, TReK CFDP console 

application, or TReK CFDP Library).   In addition, the bit rate directive is not part of the 

CFDP Blue Book and is only supported by the TReK CFDP implementation of Native 

CFDP. 

 

TReK also provides the capability to create CFDP dropboxes to push files to a remote 

destination.  The dropboxes are available in both Native and ION CFDP modes.   

Dropbox configuration parameters include where the dropbox is located and the 

destination of each file placed in the dropbox. 
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In addition to this application, TReK also includes a CFDP console application and a 

CFDP library.  If you need CFDP functionality onboard a spacecraft consider the TReK 

CFDP console application.  If you need to include CFDP functionality in your own 

application, consider the TReK CFDP library.  The TReK CFDP library can be used to 

include CFDP functionality in a ground or flight application. 

  

4 Overview of the User Interface 

4.1 Main Window 

The main window contains several areas as shown in Figure 2.  Each area is a dock 

window that you can float or dock.  To float a dock window, use your left mouse button 

to click and hold the title area while dragging the window to another area of the screen.  

To dock, use the title bar to drag the dock window over the main window and drop. 

 

 

Figure 2 Main Window 

Toolbar 

The toolbar at the top of the window provides quick access to configure the application 

and start and stop the CFDP service.  

 

CFDP Commands 

The CFDP Commands area provides a way to add and execute one or more CFDP 

commands (primitives).  For example, you can add a “put” command to send a file to a 

remote entity.  The “Show Directory” button provides access to the local file system.  

Files can be dragged from this view of the local file system or from a file explorer 

window.   Files can also be added by pushing the Add Row button and typing in the file 

transfer information.  To delete a file from the list put your cursor in the row you would 

like to delete and push the Remove Row button.  To delete all files in the list push the 
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Clear All button.  The Export List button provides a way to save the list of CFDP 

Commands in a file.  The Import List button provides a way to load a list of CFDP 

Commands from a file.  Each CFDP command entered into the list must include a 

directive, transmission information, the absolute path of the source file, the Remote 

Entity ID (Remote EID), and the absolute path of the destination file.  To execute all the 

CFDP commands in the list, push the Execute All button.  After you push the Execute All 

button, the Restore All button can be used to restore the list of commands.  The Restore 

All button will only restore the list of CFDP commands previously sent by pushing the 

Execute All button.  The Default Destination menu can be used to identify a default 

destination.  This can save typing when dragging and dropping files into the list.  If the 

Default Destination is set, the destination selected will automatically be copied into the 

Destination field when a file is dropped into the list.  The Default Destination menu can 

be populated using the Configure dialog.   

 

Note:  You can enter the absolute path for a directory in the Source and Destination 

fields.  All the files in the first level of the directory will be transferred.  Subdirectories 

will not be transferred.  Each file in the directory will result in the execution of an 

individual CFDP Command (primitive).  Therefore, the transactions area will contain 

transaction information for each file transferred. 

 

Note 2:  There are two types of configuration files for the CFDP application: the CFDP 

Application Configuration File and the CFDP Commands List file.  File/Save/Save As 

can be used to save an Application Configuration File.  The File/Open command provides 

a way to open an Application Configuration File.  The Export List button provides a way 

to save a CFDP Commands List file.  The Import List button provides a way to load a 

CFDP Commands List file.   

 

Transactions 

The Transactions area displays file transfer activity.  The Configure button displays the 

Configure dialog which provides a way to show and hide columns and rearrange the 

order of the columns.  To Clear, Pause, Resume, or Cancel one or more transactions, 

select the transactions in the list and push the desired button.   

 

Message Area 

The Message Area displays important status and error messages.  The message area can 

be cleared using the View menu. 

 

 

4.2 Toolbar 

The toolbar provides visual information about the state of the application and provides 

access to common application functions.   

 

Configuration Status 
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When the Configuration status is black, this indicates the application has not been 

configured.  When the Configuration status is green, this indicates the application has 

been configured and the CFDP service can be activated.   

 

Use the Configure button to access the Configure dialog to configure the application. 

 

Operational Status 

When the Operational status is black, this indicates the CFDP service is inactive.  When 

the Operational status is green, this indicates the CFDP service is active and file transfer 

is supported.  The application must be properly configured before the Activate button will 

be available.  The CFDP service must be active before the Deactivate button will be 

available. 

 

Use the Activate button to activate the CFDP service.  This will initiate all internal 

activities needed to prepare the application to send and receive files.  When you activate 

the CFDP service, you will see activation status messages in the main window message 

area.   If you need to reconfigure the CFDP application, deactivate the CFDP service, and 

then push the Configure button to reconfigure. 

 

5 TReK CFDP Tour 

Sometimes it’s easier to learn how to use an application by example.  This section 

describes how to use the CFDP application to transfer a file using Native CFDP.  To 

learn about transferring a file using ION CFDP, please reference the TReK DTN 

Tutorial. 

 

This section was written assuming that you have read the Introduction section and the 

Main Window section.  If you have not read these sections, please go back and read 

them.  They contain important information that is not repeated in this section.   

 

If you have a firewall enabled on your computer, you may need to turn it off or allow 

traffic through for the ports and protocols used in this example. 

 

Please go through the tour in order.  Some sections depend on data from previous 

sections. 

 

 

 



TREK-USER-0006 

 9 

 

 

 

 

 

How to Transfer a File 
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5.1 How to Transfer a File 

The following steps describe the minimum necessary to transfer a file using Native 

CFDP.  Typically CFDP involves transferring files from one computer to another 

computer.  An instance of the CFDP application is run on each computer.  The two CFDP 

applications communicate with each other using the CCSDS File Delivery Protocol 

(CFDP).  While normally you run an instance of the CFDP application on each computer, 

it is possible to run two instances on the same computer (doesn’t make a lot of sense but 

is possible).  In this configuration, you can transfer a file from one directory to another 

directory on the same computer.  To avoid the need for two computers, this is the 

approach taken in this tutorial.  The steps below describe how to use two instances of the 

CFDP application running on the same computer to transfer a file from one directory to 

another directory on the same computer using Native CFDP. The configuration that will 

be used is shown in Figure 3.   

 

 

 

Figure 3 Tutorial Configuration 

 

While you will be doing this on a single computer, the steps to configure and run will be 

the same steps when you do this with two computers.    

 

 

Step-By-Step 

 

1. If you haven’t started the CFDP Application, use the operating system’s menu to start 

the application.  You should see the CFDP main window shown in Figure 4.  We will 

refer to this instance as CFDP Instance 1.   

 



TREK-USER-0006 

 11 

 

Figure 4 CFDP Main Window 
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2. The Configuration Toolbar at the top of the main window contains a Configure 

button.  Push the Configure button to display the Configure dialog.  You should see 

the dialog shown in Figure 5. 

 

 

 
Figure 5 CFDP Configuration Dialog 
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3. Ensure Native CFDP is selected.  The Local Entity ID is the Entity ID that will be 

used by this CFDP application when it performs a file transfer.  It defaults to 1.  

This is the EID that should be used by CFDP Instance 1.     

 

Note:  If you have identified you will be using the CFDP capability in your 

Payload Integration Agreement, you will be assigned a “Ground Node ID”.  The 

Ground Node ID is an Entity ID and should be entered into the Local Entity ID 

field.  If there are multiple people on your team, your team may have more than 

one Ground Node ID.  Each team member who needs to run the CFDP application 

will need a unique Entity ID. 

 

4. The next step is to identify the remote entity that this CFDP application will 

communicate with.  This will be CFDP Instance 2 (which we have not started 

yet).  Push the + button to create a row to enter the Remote Entity information.  

Type in the following information: 

 

Remote Entity ID: 2 

Remote IP Address: <Your Local IP Address> 

Remote Port:  4545 

 

Note:  The CFDP application can communicate with one or more remote entities. 

 

Your dialog should now look similar to the dialog shown in Figure 6. 
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Figure 6 Configuration with Remote Entity 

  

 

5. Ensure the CFDP Socket Local IP Address and the Remote IP Address contains your 

local IP address.   

 

6. All the other defaults in the dialog are acceptable. 
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7. Push the OK button to save the configuration information and exit the dialog. 

 

8. If the application is configured correctly, the Configuration status in the main window 

will be green as shown in Figure 7.  If you do not see green, the most likely problem 

is the local IP address.  Verify that you have entered a valid local IP address for your 

computer. 

 

 

Figure 7 Configuration Status 

 

9. Go to the File menu and save the configuration naming it CFDP_Instance_1.  This 

will update the application title bar and make it easier to distinguish between the two 

instances once we have both instances running.  This is shown in Figure 8. 
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Figure 8 CFDP_Instance_1 

 

10. Push the Activate button located in the Configuration Toolbar in the main window.  

This will activate all the underlying services needed to perform CFDP functions.  If 

activation is successful, your main window should look like the one shown in Figure 

9.  The Operational Status will be green. 

 

 

Figure 9 CFDP_Instance_1 Activated 
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11. Now that one instance is configured and running, launch a second instance of the 

CFDP application. 

 

12. In the second instance of the CFDP application, push the Configure button and update 

the following: 

 

Local Entity ID:   2 

Remote Entity ID:   1 

Remote IP Address:  <Your Local IP Address> 

Remote Port:   4560 

CFDP Socket Local Port:  4545 
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Figure 10 Configuration for CFDP_Instance_2 

 

 

Note:  Now that you have configured both instances you can compare the configuration 

information.  You configured each instance with local entity information and remote 

entity information.   Both instances have information needed to communicate with the 

other.  As a reminder, the tutorial configuration is shown in Figure 11. 
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Figure 11 Tutorial Configuration Reminder 

 

 

13. Push the OK button to save the configuration information and exit the dialog. 

 

14. Verify the Configuration status is green. 

 

15. Go to the File menu and save the configuration as CFDP_Instance_2.   

 

16. Push the Activate button located in the Configuration Toolbar in the main window.  

This will activate all the underlying services needed to perform CFDP functions.  If 

activation is successful, the main window for CFDP Instance 2 should look like the 

one shown in Figure 12.  The Operational Status will be green. 

 

 

Figure 12 CFDP_Instance_2 

 

 

17. You are now ready to transfer a file.  The easiest way to identify the file(s) you want 

to transfer is to use drag and drop to drop the file(s) into the main window CFDP 

Commands list.  To get some extra help from the application, you can set some 

application defaults that will fill in information in the CFDP Commands list when 
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you drop files into the list.  So before transferring a file, let’s set the defaults used by 

drag and drop.  Push the Configure button in the main window configuration toolbar.  

Go to the Options tab.  Set the Default Remote EID to 2 as shown in Figure 13. 

 

 

Figure 13 CFDP Configuration Options Tab 

 

 

18. Push the + button to add a row to the Default Destination Paths list.   Enter the 

absolute path for your home directory (<C:\Users\<your username> on Windows or 

/home/<username> on Linux) on your computer.  Your dialog should be similar to 

the one shown in Figure 14.   
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Figure 14 Default Destination Path 

 

When you drag and drop a file the Remote EID will automatically be populated for you 

with the Default Remote EID.  The Default Destination Paths will appear on the Default 

Destinations menu in the application (more on this below).   

 

19. Push the OK button to save the configuration information and exit the dialog. 

 

20. In the main window under the CFDP Commands list, there is an option menu called 

Default Destinations.  Select the path you entered in the Default Destinations list in 

the Configuration dialog (<C:\Users\<your username> on Windows or 

/home/<username> on Linux).  Your CFDP_Instance_1 main window should look 

like the one shown in Figure 15. 
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Figure 15 Main Window with Default Destination Selected 

 

 

21. Let’s transfer a file.  Open a file explorer window and select a file to transfer.  Make 

sure it is not a file in your home directory since that is the destination of the file.  

Drag the file from the file explorer window and drop it into the CFDP_Instance_1 

CFDP Commands List.  If all the information about the file is valid, your main 

window should look similar to the one shown in Figure 16. 
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Figure 16 CFDP Commands List 

 

Let’s take a look at what we have in the list.   

 
CFDP Command Syntax [CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path] 

CFDP Command put class2 c:/cfdptest/file1.txt 2 C:/Users/kirk/file1.txt 

 
Command Field Value Description 

Put/Get put Indicates the file will be ‘put’ (copied) from the local entity 

(CFDP_Instance_1) to the remote entity (CFDP_Instance_2) 

Transmission class2 Class 2 ensures reliable file delivery; any required 

retransmissions are requested and performed by CFDP. 

Source C:/cfdptest/file1.txt Identifies the ‘source’ file you wish to transfer to the 

destination (CFDP_Instance_2).  (Note:  Double quotes are 

not required when entering data in the CFDP Commands 

List.) 

Remote EID 2 Identifies the remote entity ID is 2. 

Destination C:/Users/kirk/file1.txt Identifies the ‘destination’ file by providing the absolute 

path and filename that should be used when the file is placed 

at the destination.  (Note:  Double quotes are not required 

when entering data in the CFDP Commands List.) 

 

 

22. Everything is ready to go.  Push the Execute All button in the CFDP_Instance_1 main 

window.   

 

23. You should see the Transactions area populated with transaction information in both 

the CFDP_Instance_1 main window and the CFDP_Instance_2 main window as 

shown below in Figure 17 and Figure 18.  Use the file explorer window to look at 

your home directory and you should see the file you transferred. 
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Figure 17 CFDP_Instance_1 Transaction Information 

 

Figure 18 CFDP_Instance_2 Transaction Information 

 

 

That’s it!  You have successfully transferred a file using CFDP.  For more information 

please see the TReK CFDP User Guide. 

  

Happy Transferring!!! 


